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Symbols Used in this Training Manual 
 
 

 

TIP 

Tips provide general recommendations to enhance efficiency or effectivness. 

 

 

CAUTION 

Cautions indicate that special attention may be important to your success. 

 

 

NOTE 

Notes emphasize special information about the function or process. 

 

 

Illustrations and Graphics 

Screen shots provided in this manual may show a view or system configuration that is 

slightly different from the screens and configuration in use at your organization.  

 

 

Additional Information and Resources 

� This training manual provides a general overview of the Harmony Advanced Reporting  

solution, which is an advanced tool for reports development. To ensure success, users 

need at least basic skills in working with data sets, developing reports, using structured 

queries, and manipulating data and results.  

� Users should also have a working knowledge of the data available for their organization. 

A review of the organization’s Harmony for Aging configuration (set up of services, 

organizational attributes, client demographics, etc) may be useful.   

� Please refer to the applicable product documentation for information about the 

transactional system and related products in the Harmony for Aging and Adult 

Services suite.   

� Harmony Advanced Reporting contains commercially available Microsoft technology 

components. There are multiple online resources including Microsoft itself, for tutorials 

and product information about these components. This guide will avoid duplication of 

guidance and training resources available elsewhere for the Microsoft components of the 

solution.  Links: 

• http://technet.microsoft.com/en-us/default.aspx  

• http://technet.microsoft.com/en-us/library/default.aspx  
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Harmony Advanced Reporting – Solution Overview 

Harmony Advanced Reporting (Advanced Reporting, AR) is the custom reports module 

for the Harmony for Aging and Adult Services (Harmony for Aging, HfA) product line. 

Advanced Reporting is a web-based, self-service reports environment that enables 

authorized users to access the organization’s Harmony-hosted data warehouse (DWH).  

User Roles 
At present, there are two user roles for the AR Module: 

• Report “Runner” (runner) – this user role permits access to the storage areas of 

the solution. Runners may execute (run) available reports, and may retrieve 

reports that are auto-generated on a pre-defined schedule. 

• Report “Writer” (writer) – this user role includes the permissions of the runner role 

with expanded access to develop datasets, report definitions, reports, and 

reporting objects for use against the DWH.  Report writers can create a wide 

variety of charts, graphs, and reports “on the fly.” These items can be saved in a 

variety of formats and modified as needed.  

 

Features and Components 

The Harmony Advanced Reporting solution is a Harmony-hosted module that includes a 
“back end” DWH, a “front end” self-serve reports portal, and a report design studio that 
communicates between the two, The components are also connected by a variety of 
automated data conversion processes that periodically add to the available data. 

Advanced Reporting runs on Microsoft technologies: 

• SQL Server 2008R2 – database and source DWH for the solution. 

• Report Builder 3.0 – development studio for dataset/report design and creation. 

• SharePoint 2010 – user portal with storage for reports and report objects. 

 

SQL Server 2008R2  

The heart of the solution is Microsoft’s SQL Server 2008 and its associated SQL 

Reporting Services.  SQL Server is a powerful database that works with T-SQL syntax. 

(Syntax is the “query language” used to retrieve information from the database). SQL 

Server is a relational database in which data are organized in tables having rows and 

columns.  Many modern systems, including Harmony for Aging, use relational databases 

to store information. A relational database may be designed for transactional use (write 

many, read once) or for reporting use (write once, ready many). Harmony for Aging is 

designed for transactional use. In the Advanced Reporting solution, the database pulls 

transactional data into a reporting-formatted database. 
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To create the Advanced Reporting database, the data within Harmony for Aging is 

extracted from the transactional system, and is then transformed into the correct 

structure for use in Advanced Reporting. Once the data is transformed, it is uploaded to 

the Advanced Reporting database. This process of converting data from the source to 

the reporting solution is called ETL (abbreviation for Extract, Transform, and Load).  

Harmony transfers the data from Harmony for Aging to Advanced Reporting on a 

periodic basis. Each upload is called a “data refresh.”  Reports always run against the 

current data in the Advanced Reporting database, and the report will always return the 

same results until something changes due to a data refresh. If you want a snapshot in 

time before the next refresh occurs, you will want to export the report to a save-able 

format such as .pdf or .xls. If you prefer, you can establish a subscription that will keep 

the old version and add a new one with each update to the DWH.    

 

Report Builder 3.0 – Design Studio 

Report Builder is an advanced query editor and presentation design suite with tools that 

enable development of datasets and report definitions.  Writers can import or paste SQL 

queries developed outside of Report Builder to create reports. (Adjustments to syntax or 

table and field names may be needed to enable an imported query to run). Report 

Builder acts as a “communicator” that brings the “back end” data and the “front end” 

collection of stored objects together.   

The design features of Report Builder deliver countless options through an interface that 

looks a lot like Microsoft Office 2010. Users who are familiar with Office 2007 and 2010 

will have little difficulty getting oriented to the layout and functionality of the Report 

Builder interface and its ribbon bars.  

A rich collection of product information is  freely available from Microsoft.  For those who 

want to learn more, we recommend a read-through of the content located on Microsoft’s 

TechNet site at http://technet.microsoft.com/en-us/library/ms155938.aspx . 

 

SharePoint Portal  

The solution’s “front end” is a SharePoint portal that consists of a site collection with one or 
more sites and several libraries that store report objects.  These terms have specific 
meaning: 
 
1. Site Collection 
 

A site collection includes a master site and its associated subordinate sites.  The 
master site has “parent” status in the hierarchy. For instance, the Advanced Reporting 
solution for a statewide deployment might include one site collection comprised of a 
(master) state site that can access  each Area Agency on Aging  (AAA)-level site in the 
deployment.  
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To access any area within a site collection, a user must have permission to get to the 
site collection. State-level users can typically see a consolidated view as well as data for 
any of the associated agency sites. Agency users can typically only see the data and 
information associated with their agency’s site.  
 

Sample Advanced Reporting URL for a statewide site collection:  

https://reports.harmonyis.net/state 
 
2. Site 
 

A site is a shared workspace that belongs to a site collection. Sites can store a variety 
of shared content, and the site can be configured with folders to keep files and objects 
organized.  Permissions for a site can be inherited from the site collection (parent) or the 
inheritance can be severed to enable permissions unique to a site within the collection.  
 

Sample Advanced Reporting URL for a statewide site collection:  

https://reports.harmonyis.net/state/AAA 
 

 
3. Library 
 

A library is a repository where objects may be stored within a site.  A site can have zero 
to many libraries.  In the Advanced Reporting solution, each site has three libraries. One 
library is “read only” and the others permit a variety of functions.  
 
Central to the libraries is the read-only Data Source Library. This library stores 
metadata about the Advanced Reporting data warehouse (DWH), and enables 
connection to the Advanced Reporting database where the DWH runs.  
 
The second library is the Reports Library, where report objects and documentation may 
be stored.    
 
The third library, Reports Executed Library, is where the system saves reports that are 
auto-generated.   

 
Sample Advanced Reporting URL for a statewide site collection:  

https://reports.harmonyis.net/state/AAA/ReportsLibrary 

 

4. Report Objects 

Report objects encompass files, folders, and images stored within a library within a site 

within a site collection.  Typical report objects include datasets (.rds files), report definitions 

(.rdl files), data models, documentation, images (logos, photos), and similar report parts that 

can be used independently or together to create customized reports.  
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Solution Access 

Users are licensed for writer or runner access, and each user must have an 

AgingNetwork (an.com) account.  Users are associated to the correct role and database 

(db) name(s) during Advanced Reporting configuration. The assigned role determines 

which components, site collection, sites, and libraries can be accessed by the user.  

• All users have rights in SharePoint, which is accessed through a web browser 

using a secure (https) connection protocol.  

• Writers have additional rights in Report Builder 3.0, which is accessed 

through Aging Network.   

 
Before we begin the step-by-step instructions, some additional detail is needed to define  
what the Advanced Reporting solution does, and to cover some terminology associated with 
its capabilities.  
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What is a Report? 

While it may seem a very basic place to start, this section may help put the solution into 

context for users with limited prior experience in report development.  

Simply put, a report consists of three major components: 

 

 

1.   Data. 

The data for your reports must come from a data source.  

In this solution, you will select from the data source provided, or 

you can connect to a subset of the datasource provided.  

You can decide whether to use all of the data in the default 

dataset or you can filter the data and select only the elements, 

tables, or calculations that you need.  

 

2.  Presentation. 

The output of a report is determined by the report writer’s design 

decisions, starting with a selection of a report’s “type” (table, pie, 

bar chart, etc) and the arrangement and behavior of elements 

and report parts that define the report’s formatting, graphics, 

and layout. 

 

 

3.  Computing. 

Reports are created by processing data to answer questions.  

Generating a report may involve math (addition, multiplication, 

ranking), statistics (averages, thresholds, and similar functions) 

or the application of conditional logic (if-then, parameters, 

filters), and/or interpretive manipulation or evaluation (grouping, 

sorting) of the selected data.  

To write a report, you will connect to a data source, define the data you seek within the 

data source, specify the processing needed for your report’s results, and design the 

output so the results and data display in conformance to your desired requirements.  

Sometimes these steps are performed in a different sequence: Choose report type, 

Connect to dataset, Specify required processing.  Either order works.  

Whatever the sequence, Report Builder is where report writers will design, define, 

generate, save, modify, and manage reports, datasets, and related elements.  

SharePoint is where writers will store, schedule, and retrieve report objects.  
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Datasets and Report Definitions 

Continuing from the prior section, let’s take a look at how the three components: Data, 

Presentation, and Computing specifically come together in the Advanced Reporting solution.   

 

 

1.   Data = Dataset = filename.rsd 

Once you connect to the solution’s data source, you will use 

the source to create smaller subsets of data for reporting.  

In Advanced Reporting, you’ll create these subsets as shared 
data sources called datasets.  Using Report Builder, you will 

write a query, run it against the data source, and save the 
results of your query in the format of filename.rsd.  

 

2.  Presentation = Report Definition = filename.rdl 

In Advanced Reporting, you’ll create report definitions using 

Report Builder. You’ll select a dataset, and then choose the 

tables and fields you need for the report. Then you’ll define 

relationships, grouping, filtering, and parameters.  Finally, you’ll 

arrange the fields for display, and design the report’s labels and 

layout and save your work in the format of filename.rdl. 

 

3.  Computing = <<Expression>> 

In Advanced Reporting, writers can take advantage of automatic 

grouping and aggregation features, and can also fine-tune 

report designs through the use of entirely custom SQL and 

complex expressions. In addition to computing as logic, a key 

feature of the solution enables configuration of report 

subscriptions, where the system autogenerates report outputs 

on a defined schedule.  

 
 

 

CAUTION 

Once you develop a custom report, pay attention to any modifications 
that you make to any of the components.  Change control is important! 

If you modify a dataset, test your changes carefully, because all 
reports using that dataset will be impacted.   

If you change a report definition, “Save” means all instances of the 
report will be modified going forward. “Save As” with a new name 
means people can still run the old report under the old definition.  

If you change a subscription, the delivery schedule may be modified, 
so you may want to notify the recipients of the change.  
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Writing Reports 
 

Approaches to Report Creation 

There are several approaches for writing custom reports using Advanced Reporting: 

 

Option 1:  Import and manipulate, or directly develop SQL. 

This option is suitable for the more advanced report writer who is comfortable with 

syntax and the features available in Report Builder.   The approach can be used for 

writing new reports and for modifying reports written outside of Advanced Reporting.  

This approach allows you to insert complex clauses and expressions to enhance your 

queries, and it enables you to make use of a ton of Internet resources that provide 

ready-to-use code to solve the more challenging report problems a writer can face.   

 

Option 2:  Write reports using embedded datasets. 

Writers can use the easy-to-follow Report Wizard in Report Builder to create a report 

that “bundles in” the underlying elements that provide the data.  This approach can be 

more efficient for ad hoc reporting needs, and is generally a faster path to report 

development.  The down side to this approach is that embedded data sets are only 

usable for the one developed report, and you cannot reuse the dataset or report 

definition to produce other report objects.  

 

Option 3:  Develop separate datasets and report definitions.   

When you develop separate objects, your work can be reused.  While it may take a little 

longer, in the long run it’s more efficient.  As your datasets become more complex, the 

value of this approach becomes increasingly obvious.  It’s also easier to establish 

standards for separate objects, which can be important to larger organizations where 

multiple writers share custom report maintenance responsibilities.  

 

Most writers will learn to use all three approaches.  
 

• Where objects are good candidates for reuse, separate objects usually make the 

most sense.  

• For ad hoc needs, embedded datasets may be the quickest way to go.  

• In both cases, SQL import and manipulation can be a necessity when you begin to 

push the boundaries of what Report Builder can offer within the features of the 

graphical interface.  
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Process of Report Creation 

Regardless of the selected approach, the high level process is the same.  

 

Step 1:   Connect. 

Whether you need to run a report or write one, everything begins with a connection to 

the system.   For writing a report and using Report Builder, you will need to connect to 

the database. 

 

Step 2:   Query. 

Every report needs a query that returns results.  You can paste in a SQL statement from 

elsewhere, you can use the graphical interface to write a query, you can use an existing 

dataset to serve as your query, or you can embed a query into your report.   

The query may be used entirely to retrieve data, or it can sometimes be used to format 

and manipulate your results set in advance of designing the report definition and layout.  

Over time, experience will help you determine when it’s better to handle formatting in the 

query and when it’s better to let the layout handle the task.  

The query has to address at least SELECT and FROM, and often includes additional 

clauses to specify JOIN and WHERE statements, which may include parameters. 

 

Step 3:   Design.  

In this step you define row groups, column groups, and values that will be used in the 

report.  You can set properties for groups, add group expressions, and specify how the 

display will behave with formatting options.  If using the wizard, you can choose options 

for subtotals and grand totals and you can apply themes to add some color.  

 

Step 4:   Finalize. 

Once you have a report that returns data, you can test the results and finalize the 

design. You can toggle back and forth between Run mode and Design mode to fine-tune 

both layout and presentation.  Add a title and some built in fields, set pagination and 

print layout, and define a header and footer if desired.  

 

Step 5:   Save. 

Before you run the report for the first time, and after making changes you want to keep, 

you will need to save the report.  Report objects (datasets, report definitions, imported 

reports, and embedded reports) are stored in the Reports Library within your site’s 

SharePoint portal.  Once saved, you can establish an auto-generated run schedule if 

you wish.  
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Report Builder for Datasets and Reports 

 

Accessing Report Builder via AN.com 

Only those users with writer role permissions will be able to access Report Builder.   

To access Report Builder via AgingNetwork.com, follow the steps outlined below: 
 
 
1.  Go to:  http://www.agingnetwork.com/  and click Go to Customer Login. 
 

 
 
 
2.  Enter your AgingNetwork Username and Password credentials, then click Login. 
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3.  Double-click the Reporting Solutions Folder.  

Your folder name may vary.  When you log into AgingNetwork.com, the system will 

show you all of the folders for which you have permission.  If necessary, browse the 

available folders to locate the Report Builder 3.0 icon.  

 

 

 

 
4.  SINGLE - click the Report Builder icon (#1 below) to launch the component.  

 

 

The Citrix MetaFrame window (#2 above) will open and Report Builder will load.  

Be patient – it takes several moments for Report Builder to open. 
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Report Builder Launch 
 
The system will launch the Report Builder application.  
 

 
 
 

Once Report Builder has loaded, the system may request credentials to access the 

database.   You will typically need to provide these credentials the first time you connect to 
the DWH. You can check the “Save password with connection” box to store the 

credentials so as to speed your connections in the future.  

 

 

 

 



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 13 

Upon connection to the database, the system will open the Report Builder interface.  

 

 
 

The Report Builder application is a powerful design studio for query development and 

report design.  It can take a long time to learn all of the available features, and most 

users will never take advantage of every available option.  

This training focuses on the basics that every new writer will need to know.  From there, 

it’s up to you to build upon this foundational knowledge and to work at developing the 

level of proficiency that meets your individual needs and requirements.  

To begin our exploration of the Report Builder component, the next section covers the 

user interface to help you become familiar with navigation and layout of the most-used 

features. 

 
 



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 14 

The Report Builder Interface 
 
The initial view into Report Builder is comprised of two layered windows: 
 
 
Window 1: Getting Started 

When you first open Report Builder, the system gives you a graphical wizard.  

 

 

 
 

 

You can use this wizard to: 

� Create a New Report (Table, Chart, Map, or Blank). 

� Create a New Dataset (Open data source and make a new, shared dataset). 

� Open a saved report (Access, manipulate, or modify an existing report). 

� Open a Recent report (Select item from list of recently used items). 
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Window 2:  Developer’s Studio 

Experienced users typically close the Getting Started window and go directly to the studio. 

Within the studio, developers have access to a comprehensive authoring environment.  

When working with datasets, the studio will present a dataset view. When working with 

report definitions, the studio will present a report design view.  

 

TIP 

SQL Server uses T-SQL syntax.   

Developer’s Studio View 

 
 

The “look and feel” are very similar to MS Office 2010.  

  

Two important features are included in Report Builder: 

1. Developers can use the studio’s query editor (Edit as Text) capability to paste in 

(or import), modify, and run SQL statements that were developed elsewhere.  

2. Report Builder ships with impressive online Help files.    

Simply locate the question mark icon in the upper right 

corner of the window, and click it to access online help 

files. You can search for specific topics or select from 

the index of available subject areas.    
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Working in Report Design View 

The following screen shot comes from Report Builder’s online help file. You are strongly 

encouraged to read the entire section called “Working in Report Design View.”  

 

 

Home Tab 

The Home tab displays a ribbon for query execution, a clipboard, and formatting options.  
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Run Tab 

The Run tab appears when you click Run on the Home tab.  

 

 

The Run tab launches an HTML viewer that lets you preview your 

report.  The tab allows you to toggle back and forth between the 

Run ribbon and the Design ribbon.  

You can use the options in the Run ribbon to set up the report for 

printing, to navigate through the pages and properties, and to 

export the report.  The Design ribbon contains formatting options. 

 

Run Ribbon 

 
The RUN ribbon has the following options: 
 

   
 
1.   Design button. 

Click this button to go back to the report layout / output design view.  

 
2.  Paging options. 

Use these controls to navigate through the report output. Note that grand totals will be 

found at the bottom of the report’s last page unless you have designed the layout to 

present totals above rather than below the report element.  

 
3.  Run controls. 
 

Refresh will re-start a query.  Stop will abort a query.  Back will take you to Design 
view. 
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Run Ribbon (continued) 
 
4.  Print. 

Print controls in Report Builder work exactly like print controls throughout MS Office 

modules.  You can define a printer destination and set any available options as desired. 

 

 

5.  Page Setup controls. 

Page setup controls in Report Builder closely resemble MS Word options. 
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Run Ribbon (continued) 
 
 
6.  Print Layout button. 

Use the Print Layout button to “print preview” the output.  

 

7.  Export button. 

The Export button enables conversion of output to an alternate format. 
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Design Ribbon 

 

To return to the work pane, click Design.  This exposes the Design ribbon.  

 
 

 

The DESIGN ribbon has the following options: 
 

 
 

1.   Run button. 

Click this button to execute the query and test the report results.  

 

2.  Clipboard options. 

Use these controls to copy, cut, and paste within the report design.  

 

The controls for items 3 – 7 in the Design ribbon work exactly like the ones in MS Office. 

3.  Font options. 

4.  Paragraph options. 

5.  Borders and Shading controls. 

6.  Number format options. 

7.  (Grid) Layout options. 
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Insert Tab 

The Insert tab displays a ribbon for embedding report parts and other items into your layout.  

 
 

You are encouraged to read more about Report Parts in the help file. Report Parts are like 

“widgets” that have some special properties.  You can share them, reuse them, publish 

updates from a server, and “push” the changes back out to all the instances where the 

report part is used in a report.   

 

 

View Tab 

The View tab displays options to show or hide parts of the Report Builder interface. 

 
 

Of special interest on the View Tab is the option to display Properties.  When this box is 

checked, you will be able to modify report properties from a list of objects, some of which are 

not readily apparent unless this option is turned on.  

 

When the Properties box is turned off, you can still modify properties, although it generally 

involves right-clicking fields in the design pane and then searching for the options to be 

modified.  
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Design Surface 

The Design Surface, which appears with the Home Tab in view,  is the primary development 

area.  Here you will insert report objects and define other attributes of your report design to 

create a report definition (.rdl file).  

 

 

Report Data Pane 

The Report Data Pane, located underneath the Run button, 

contains the resources available for use in your report. 

Items available in the Report Data Pane can be dragged 

onto the Design Surface and placed into the appropriate 

position.  

 

Built-in Fields:  Built-in Fields are global and user 

variables that can be pulled into the design surface. On the 

design surface, these variables display with an ampersand 

(&).  Most users of Microsoft Office will recognize that these 

fields work exactly like adding standard fields to headers 

and footers in MS Excel.  
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Report Data Pane (continued) 

 

Parameters:  Parameters are used to customize values (for data, appearance, behavior, 

and filtering).  Report parameters are created automatically for each query parameter 

that you include in a dataset. The parameter‘s data type determines how it appears on 

the report view toolbar.   

Images:  Images include files in any supported format (.gif, .png, etc).  A common use of 

images in reports involves adding logos or pictures to enhance a report’s appearance. 

Data Sources are the locations for a source of data or the source of data for objects 

(cubes, for example), or a data source may be the information about how to access a 

data source (data source type, connection string, and credentials).  Once available in the 

Report Data Pane, one or more data sources can be used to build a report definition. 

Data Sources can be saved separately to a report server and shared among report 

projects or they can be embedded within a report definition (.rdl) file.   

A connection saved in a report creates an embedded data source, which is specific to a 

single report as part of the report definition (.rdl) file. Connections may also be saved on 

a report server for a shared data source, which can be used by multiple reports.  

Datasets are comprised of a data source definition, a query definition, and any optional 

parameter values or processing logic (calculated fields, filtering, sorting, etc.). A report 

definition (.rdl) file must have at least one associated data set.  An .rdl file can also be 

associated to multiple datasets. 

Grouping Panes 
Grouping moves data together in the final display at run time based on defined 
attribute(s).  For instance, many organizations wish to see expenditure reports that 
group or subtotal by Service, by Provider, by Fund Identifier, or by Date. The Grouping 
Pane is where you set these requirements for the report’s design.  
 
Groups may be set by row or column, and can be quite advanced in behavior when 
multiple groups are applied.  Most users will initially build reports with simple grouping 
such as by time, geography, or other dimensional hierarchy where subtotals are desired.  
 
You’ll want to read the help file under topic “Understanding Groups” if you don’t have 
prior experience with creating and using “Group by” expressions in report development.  
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Create New Report Wizard 

 

Having explored the Report Builder interface, let’s see how we can use Report Builder to 

write custom reports.  Using the Report Wizard results in an embedded data set.  

 
The wizard takes you through all of the following design steps: 
 

1.  Choose a Dataset- 2.  Design Query - 3.  Arrange Fields - 4.  Finish Layout 
 
 
First, access the Report Builder icon (AN.com) and launch Report Builder.  
 
The system will open Report Builder and its Graphical Report Wizard. 
 
 
Graphical Report Wizard Interface 

 

 
 
 
Starting within the graphic interface, select New Report > Table or Matrix Wizard. 
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The system brings up the first step in the wizard –  Choose a Dataset. 
 
If we were editing a report, or if there were already shared datasets in the system, we could 

work with what’s there and make modifications.   When building a new report  from scratch, 

however, we first have to “create” the dataset.  

 

 

STEP 1:  New Report Wizard:  Choose a Dataset  

 

 
1.  Select Create a Dataset and click Next. 

 

 
 

Next, we’re going to choose a connection, which means accessing the DWH by browsing 

to the Data Source Library in SharePoint. 

 

2.  Click Browse. 
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The system will bring up the Select Data Source window.  Double-click the available 
data source to drill down to the available files.   
 
State-level users may have more than one available option.  Agency users should 
only see the data source for their agency.  
 
Double-click the the Data Source Library folder to open it and select the correct .rsds 
(Data Source) for your organization.  
 
3.  Select the correct data source so the file appears in the Name box, then click Open. 
 

 
 
 
Once you select the data source, you can test the connection. 
 
4. Click Test Connection, and if successful, click OK.  
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On your first connection, the system will prompt you for connection credentials.   
 

5.  Enter the connection credentials.  

You can click the box for Save password with connection to speed access in the future.  

 

 
 
 

When the correct credentials are supplied, the system will connect to the DWH, and will 
bring up the next screen in the New Report Wizard:  Design a Query.    

 

This screen contains the graphical query builder interface, which is comprised of the 

Explore Pane, the Design Pane, and the Results Pane.   

 

The query builder enables you to access and work with various elements of your data 

source to design a report.  

 

 

 

TIP 

As noted earlier, you can use the query builder feature to 

import or paste in SQL statements and related code 

developed outside of the Advanced Reporting solution. 

When this interface is used for working with stored 

procedures, the Results Pane section of the window will 

not appear.  
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STEP 2:  New Report Wizard:  Design a Query  

 

Design a query Window 

 

 
 

You are encouraged to click the Help button on this screen, and to read through the topic 

Relational Query Designer User Interface (Report Builder 3.0).  

 

Graphical Query Builder – Features and Functions 

Query Designer Toolbar 
 

 
 
The toolbar enables features that help you view or specify the results of a query. 

� Edit as Text – this button is a toggle to the text-based query designer where you 

can review and edit your query.  Click the button to enable the feature, and click 

it again to go back to the graphical interface. 

� Import – this feature helps you to bring into the editor an existing query from 

another file or report.  You can import .sql and .rdl file types.  

� Run Query – self-explanatory. Results display in the lower pane.  
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Explore Pane 

 
 

The Explore Pane contains the available schema elements that can be used in your report.  

Expand the Tables node to see tables and columns available in Advanced Reporting.  Use 

the same process to explore Views and Stored Procedures.   

Click the box to the left of an element to bring over an entire table (ACTIVITIES) or specific 

column(s) within the table (AGENCY).   

 

Design Pane 

The Design Pane refers to the three sections on the right of the design workspace,  

including Selected Fields (#2), Relationships (#3), and Applied Filters (#4).  

To build a query,  

1. Choose tables FROM the Database view,  2. SELECT fields from the chosen tables,   

3. Establish table JOIN(s) as needed, and 4. Specify any WHERE statement conditions.  
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Design Pane (continued) 

 

Selected Fields area (#2 above) 

In the Selected Fields area, you can set Group and Aggregate options for the query. 

Bear in mind that it may be easier to work with grouping and aggregation in the report 

layout rather than in the query.  

� Fields – this area populates with the selections made in the Explore Pane. 

� Group and Aggregate – select a field, and then click the Group and 

Aggregate button to reveal a (long) drop down list of options. 

 

Relationships area (#3 above) 

If a query uses more than one table, the database requires that you define a relationship 

between the tables chosen.  A SQL query in proper form will contain a count of join 

statements equal to one less than the count of tables chosen.  Example:  if your query 

uses three tables, you must establish two joins.  Four tables requires three joins.   

� Report Builder has a relationships feature called Auto Detect, which lets the 

system discover and define relationships. Unfortunately, the system doesn’t 

always make the correct associations, or it may not detect the correct number 

of joins needed.  

� You can define join relationships manually by clicking the Auto Detect button 

to turn off the system’s “view of the world.”  Then you can use the buttons to 

establish the left and right tables and specify the field on which to join them.   

� Joins “apply” in order of appearance, and you can move items up or down.  

� There are three most-used joins in Report Builder: 

� Left Outer:  

•  Returns all records in left table + matched data in right table 

� Right Outer: 

•  Returns all in right table + matched data in left table 

� Inner: 

•  Returns data only when there’s a “hit” in both tables 

•  Inner is the “default” if no other join is specified 

� A fourth type of join, “full outer,” should only be used by experienced 

developers. These queries return all records except the inner join results. Full 

outer can result in a “runaway query” that consumes a lot of system resources 

without being able to complete the process before it times out and fails.  

Let’s take a closer look at how joins are applied.  
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Working with Joins 
 
Let’s say we choose two tables for our query:  Consumers and Calls.  
 

 
 

Consumers is the Left table, and Calls is the Right table.   

We could swap them if we wanted to. The designation of Left and Right is somewhat 

conceptual, as there are no rules for which belongs where.   

Note that in the Consumers table, three records are highlighted in yellow. These records 

do NOT have a match in the Calls table.  In the Calls table, two records are highlighted in 

yellow. These records do not have a match in the Consumers table.  

 
An INNER join will give us only those records that appear in BOTH tables. Think Venn 
diagram here, where INNER represents the intersection of two parts: 
 

Inner Join 
 

 
 
 

Results:  
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A LEFT join, which is a form of OUTER join, will give us all records that appear in the LEFT 
table, as well as any information that can be added from the RIGHT table.  
 

LEFT (outer) Join 
 

 
 
 
Results: 

 
 
 

A RIGHT join, which is another form of OUTER join, will give us all records that appear in 
the RIGHT table, as well as any information that can be added from the LEFT table.  
 

RIGHT (outer) Join 
 

 
 
 
Results: 
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Design Pane (continued) 

 

Applied Filters area (#4 on page 24) 

This area is where you create the WHERE clause of your SQL Query.  Filters can be used 
to limit the number of records returned, and to establish certain criteria that must be met for 
a record to be reported.   
 
Filters can become especially complex when multiple filters are involved.  To add a filter, 
click the little funnel icon in the Applied Filters area, and then define the filter.  To define the 
condition(s) on the selected field, choose an Operator, Value, and Parameter setting.  
 

 

 

� Operators – select from the drop down. 

� Operators specify conditions: is, is not, like, =, etc. 

� Values – can be selected from the drop down or entered directly. 

� Values set the condition’s threshold or trigger. 

� Parameters – check the box as applicable.  

� Parameters are filters where the value is defined at run time.  

 

This query below shows the syntax generated for the WHERE clause using the 

applied filters defined above: 
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STEP 2:  RECAP:  New Report Wizard:  Design a Query 
 

From the Design a Query graphical interface,  

 

1.  Select tables and columns or stored procedures and views in the Explore Pane.   

2.  Add groups and aggregates to fields in the Design Pane. 

3.  Establish relationships.  

� You will need to specify how the tables join together.  

 

 

 

4.  Apply filters to the query (optional).  You can also use this section of the design pane 

to establish report parameters. 

 

5.  Click Next. 
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STEP 3:  New Report Wizard:  Arrange Fields 

Drag and drop the available fields into row or column groups for display. 

1.  Move into the Row groups box those fields that should display down the page. 

2.  Define your display by ordering the Column groups. 

3.  Establish at least one Value for your report.  Bring in all fields that may be summed, 

counted, averaged, or otherwise calculated.   

 

 

 

5.  Click Next.  The Wizard will take you to a preview of the report. 

 

 



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 36 

Step 4:  New Report Wizard:  Choose the Layout 

In this step, you define the default display for grouping, subtotals, and color theme (style) 

for your report. 

1.  On the first screen (shown above), Choose the Layout. Select the options that 

enable the desired subtotals and totals, and check the box to expand or collapse the 

default display of your defined groupings.  You can change your mind later if needed. 

2.  Click Next. 

3.  On the second screen (shown below), Choose a Style for your report.  Themes are 

predefined styles with complementary colors that can be applied to speed the output 

design process. You can elect to change the design later if you wish, or you can 

select the theme with no colors if you know you’ll want to modfy the appearance 

beyond the available styles.  

 

 

 

4.  Click Finish.  The wizard will place your report into the Design Pane, where you can 

continue to refine the output.   You should SAVE the report before running it.  
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Finalizing the Report Design 

 
When you are working in Report Design View, you will be switching back and forth between 
Run, which renders the report so you can see the results, and Design, which is where you 
will go to make changes to the report.  
 
Run Button    Design Button 

 

 

 
 
 
You will use the Insert Tab to add graphs, charts, and other objects.  
 

 
 
 
Use the Report Data Pane to drag available Built-in Fields onto the report’s surface. 
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New Dataset Wizard 
Writers have access to Report Builder and can use the development features to create new 
datasets. 
 
First, you will need to open Report Builder.    
 
1.  Using the graphical interface, select New Dataset. 
 

2.  Choose a data source. 

• You can select what’s presented or browse for an alternate data source.  

• If this is the first time you are connecting, you may not see a data source. 

3.  To connect for the first time, click on “Browse other data sources” to open the Select 

Data Source window.  Paste your SharePoint portal’s URL into the “Name:” field.  

• Example: https://reports.harmonyis.net/dbname/default.aspx 

 

4.  Click Open.  Browse as needed to the site’s Data Source Library and select that Library 

as your data source. 
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New Dataset Wizard (continued) 
 
 
5.  Click Create.  
 
 
6.   Upon your initial connection to the data source, the system gives you an option to store 

your access credentials for future use. Saving the credentials will speed future 
connections.  If prompted, supply the appropriate credentials to access the database: 

 

 
 
 
 
 
7.  The system will bring up the query designer interface: 
 

 
 
 
7.  Select your tables and fields, define relationships, and apply filters and parameters as 

desired.  
 
 
8.  Click Run Query to preview the results.  
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New Dataset Wizard (continued)  
 
 
9.  When the query reflects the intended dataset design, save the query (File > Save). 
 

 
 

 

9.  Save the dataset to the Reports Library as filename.rsd.  
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Report Definition Wizard 

 
Writers have access to Report Builder and can use the development features to create new 

report definitions. One option is to create a report definition using the report wizard, which 

will take you through all of the following steps: 

 

1.  Choose a Dataset - 2.  Arrange Fields - 3.  Finish Layout 

To create a report definition, first access Report Builder. If Report Builder is already 

open, you can start a new task at any time by going to the File menu and selecting New 

or Open.  You can have only one item open at any time.  

 

 
 

Let’s say you created a dataset during your review of the previous section.  Now you want to 

create a report definition following the instructions below.  The system will ”recognize” if you 

already have a work item open.  When you go to the file menu, you will be prompted to save 

the existing work before starting something new.  If you elect not to save the open item, you 

will lose any changes made since the last save.  
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Create a New Report Definition 

 
1.  Open Report Builder, or if already open, go to the File menu and select New.  
 
The system will bring up the Graphical Report Wizard. 
 
 
Graphical Report Wizard Interface 

 

 
 

 

2.  Starting within the graphic interface, select New Report > Table or Matrix Wizard. 
 

 
 
 
The system will then bring up the first step in the wizard –  Choose a Dataset. 
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STEP 1:  Report Definition Wizard:  Choose a Dataset  

 

1. Select Choose an existing dataset.  By definition, this means you will be 

connecting this report definition to a shared dataset. 

 
2. Browse to the dataset you wish to use for this report and click Next. 

 
The system will bring up the Select Data Source window.  Double-click the 
available data source to drill down to the available files.   
 
Each user will only be able to browse to authorized datasets.  
 

• State-level users will generally see the consolidated data source at 
the top of the hierarchy in the Data Source Library folder, with 
Agency-level data sources displayed below the state database.  

 
• Agencies will see just their agency. 

 

3. Navigate to the Reports Library and select <filename>_Dataset.rsd. 

 

4. Click Open. 

 

 
 
 
The system will bring up the next screen in the New Report Wizard:  Arrange Fields.   
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STEP 2:  Report Definition Wizard:  Arrange Fields 

Drag and drop available fields as desired into row or column groups for the report layout. 

You can bring over more than one field to any of the display boxes.  

1.  Move into the Row groups box those fields that should display down the page. 

2.  Define your display by ordering the Column groups, which appear across the top. 

3.  Establish at least one Value for your report.  

• Bring in all fields that may need to be summed, counted, averaged, or otherwise 

calculated.   

 

 

4.  Click Next.  The Wizard will take you to a preview of the report. 
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STEP 3:  Report Definition Wizard:  Finish Design 

 
1.  Select desired options for subtotals and grand totals, then click Next. 
 

 
 

2.  On the next screen (shown below), Choose a Style for your report.  Available 

themes are predefined styles with complementary colors that can be applied to 

speed the output design process. You can elect to change the design later if you 

wish, or you can select the theme with no colors if you know you’ll want to modfy the 

appearance beyond the available styles.  

 

 

 

3.  Click Finish.  The wizard will place your report into the Design Pane, where you can 

continue to refine the output.    

 

SAVE the report before running it. 
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4.  Run the report .  The wizard will place your report into the Design Pane, where you 

can continue to refine the output.    

 

 
 
When you are designing a report, you will be switching back and forth between: 
 

� Run, which renders the report so you can check the results, and  

� Design, which is where you will go to make changes to the report.  
 
 
Run Button    Design Button 
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Use the Insert Tab to add graphs, charts, images, and other objects.  
 

 
 
 
Use the Report Data Pane to drag available Built-in Fields onto the report’s surface. 
These fields look and act like those you may have used in MS Excel.  
 

 
 
With Built-in Fields, you can insert page numbers and total number of pages, date/time 
stamp, and similar fields.  
 
Continue making changes until the presentation results in the desired design and output. 
 
 

When report design is completed, save the file to the SharePoint Reports Library.  

From SharePoint, you can store and run the report, and you can configure the file to refresh 

the report on an automatic subscription (schedule) that you define.  



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 48 

Updating an Existing Dataset 
When you modify a dataset – all existing reports that use the dataset will be impacted. 
There are two methods to make changes to an existing dataset.  Changes may be made 
by directly editing the query in the text editor, or by using the Wizard.  

Wizard Method 

 
1.  Open Report Builder. 
 
2.  Using the Wizard, select Open. (If applicable, you can choose Recent instead). 
 

 
 
The system brings up the Open Report window.   
 

 
 
3.  In the Open Report window,  click Recent Sites and Servers (#1 above). Then drill 

down until you can “Look in” the Reports Library (#2 above), and set the Type box to 
Datasets (.rsd) (#3 above). 

 
4.  The system will bring up the selected dataset.  You can then modify the query in Report 

Builder.   
 
5.  When finished, save the results.  Use Save to overwrite, or Save As to keep the changes 

distinct from the prior version.  
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Text Editor Method 

 
This method is recommended only for experienced users who are comfortable working 
directly with SQL in a query editor.  
 
1.  Open the desired dataset.   
 
2.  Click the “Edit as Text” button.  
 

 
 
3.  Modify the syntax as desired.   
 
 
4.  Test the changes by running the query (click the ! button), or save the changes and then 

run the query. 
 
Continue making changes until the presentation results in the desired design and output. 
 
 
5.  When finished, save the results.  Use Save to overwrite, or Save As to keep the changes 

distinct from the prior version.  

 

Be sure to store your  file in the SharePoint Reports Library.  

From SharePoint, you can store and run the report, and you can configure the file to refresh 

the report on an automatic subscription (schedule) that you define.  
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Helpful Expressions 
 
There may be thousands of sites on the Internet that can help you with code segments, tips, 
and examples of expressions you may want to use in your reports. If you get stuck, try a 
Google search on the desired function or expression (remember that you will need T-SQL 
syntax). Below are a few  things you can try as you practice writing reports with the query’s 
text editor.  
 
1. Change Group Properties on a numeric field – format to two decimal places 

 =FormatNumber(Fields!FIELD_NAME.Value,2)   
 
2.  Create Drop Down list for a parameter with long lists of options (like County) 
 

a) Create a dataset with only the desired parameter field (ResCounty) 
b) Add the County dataset to your report (you will have more than one dataset) 
c) Right-Click Parameters in the report data pane – Add Parameter. 
d) Set Properties - General 

o Name Parameter: County 
o Prompt = County 
o Data Type = Text 
o Visibility = Visible 

e) Set Available Values 
o Get Values from a Query 
o Value Field = County 

f) Default Value = No default value 
 
3. Create Age_Range clause in query 
    Just before the FROM clause, insert the following syntax: 
 

   case when Age < 55 then ‘Under 55’ 
 when Age >= 55 and Age <= 59 then ’55-59’ 
 when Age >= 60 and Age <= 64 then ’60-64’ 

when Age >= 65 and Age <= 69 then ’65-69’ 
when Age >= 70 then ‘70+’ 
end Age_Range 
 

4.  Setting report parameters to pull where date between two dates: 
      Insert the following syntax: to a WHERE clause: 

 
WHERE TableName.DateField >= @DateField  
AND TableName.DateField <= @DateField2 

  
 
5. Concatenated String (displays two fields, each on separate lines in same text box): 
 

=Fields!FirstName.Value & vbCrLf & Fields!LastName.Value 
 
Note that if you want to concatenate numbers, you first must convert them to string: 
=CStr(Fields!SERVICE_YEAR.Value)&"/"&CStr(Fields!SERVICE_MONTH.Value) 
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SharePoint for Storage and Subscriptions 
Let’s explore the “front end” of the Harmony Advanced Reporting Solution.  

Accessing SharePoint 
 
1.  Launch Internet Explorer or other supported browser.  
 
2.  Enter the URL for your organization’s AgingNetwork SharePoint site. 
 
3.  Enter your credentials to log into the site (as needed).  
 

 

NOTE 

Passwords are case sensitive.  

Logins require a back-slash rather than a forward slash. 

 

 
4.  The SharePoint portal’s welcome page will appear.   
 

 

 

Each element of the portal interface page is described in the next section. 

 

 



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 52 

Portal Interface – Welcome Page 
 

 
 
1.   Browser Header – This section will contain the URL entered as well as the typical 

browser tools and options for printing and configuring browser defaults and settings.  
 
2.   Site Ribbon – The site ribbon remains visible throughout the site, and will contain 

different options depending on the user’s location within the site.  The application 
name appears on the welcome page. There are several parts to this section on the 
welcome page, explained below from left to right: 

 

a.   Site Actions drop down –  
This button is typically for administrative users only. Users may see this option 
but not all will be able to open it. The available options are explained in detail in 
the Administrative Users manual. 

b.   Navigation Up button – This provides information about the user’s context. 

 
 

c.  Browse tab – Default view of the portal’s landing page. 
 
d.  Page tab – May not be visible to most users; contains configuration options. 

e.  User Name – Displays on the site ribbon to confirm the login used to access the site. 
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Welcome Page (continued) 

 

 

 
3.  Organizational Link Bar – This ribbon contains links to the site collection’s tabs, or 

sub-sections.  The Home tab retores the view to the Welcome Page interface.   

 

In a statewide configuration, the tab to the right of Home would be the state’s tab, 

followed by any tabs established for each of the state’s associated Area Agencies on 

Aging and/or provider affiliates.   

 

 

NOTE 

The Search function  to the right of the organization 
header is inoperable, as the site is not indexed.  

 

4.  Libraries Quick Launch – The Quick Launch area contains hyperlinks to sites, lists, 

and libraries (specific SharePoint terms).  Users will typically access only the 

system’s Reports Library (b) and Reports Execution Library (c): 

a.  Data Source Library (Libraries hyperlink) 

The Libraries link is associated with the organization’s “master” datamart, 

related stored procedures, and DWH metadata. Indirect access to the 

organization’s data is established through the other libraries in order to protect 

the integrity of the datamart.  The Data Source Library is “read only.” 
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 Welcome Page (continued) 

 

 

 

4.  Libraries Quick Launch (continued) 

 

b.  Reports Library  

The Reports Library hyperlink is where shared reports, datasets, and views are 
stored. These items are made available as “standard” items included with 
delivery of the solution.  See the next section for more detail.  

c.  Reports Execution Library 

The Reports Execution Library is where the organization stores its scheduled 
outputs. 

 

 

NOTE 

Organizations are permitted to add Folders to the Reports 
Library and the Reports Execution Library, but are not 
permitted to add additional Libraries. 

 

5.   Work Pane – The Work Pane is where developers can build reports, view data, and 
perform related tasks in the system. The system’s top-level Link Bars and left-side 
Quick Launch are used for navigation, and the work pane is the developer’s “studio.” 
For Report Analysts, the Work Pane is where files, datasets, and reports appear.  
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The SharePoint Libraries 
 

The solution’s default directory structure contains Document Libraries that can be 

accessed by users having the appropriate security permissions. The area highlighted 

below illustrates the interface’s Quick Launch pane, which contains links to the solution’s 

Reports Libraries.  

 

 
 

 

Libraries Link 

 

Libraries is a hyperlink to a list of the site’s Document Libraries.  

Upon clicking the link, Users may be able to see all of the site’s Document Libraries, 

however, they can only access areas as permitted by their access role’s security 

configuration.  
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Data Source Library 

The site contains a Data Source Library, which does not appear in the Quick Launch pane. 

This library contains “read only” source data.  Harmony loads refreshed data to the Data 

Source Library on a defined schedule. Writers access the data source through the Reports 

Builder component of the solution.  Queries against the source may be saved to the Reports 

Library as new datasets. 

 

 

Reports Library 

 
Reports Library enables access to the Report Builder component of the solution, and is 
accessible by the organization’s licensed Report Writer(s).   
 
Writers can save report objects (datasets and report definition files) to the Reports 

Library.  Files in this library may be modified, and can be version-controlled using the 

Check In and Check Out capability native to SharePoint.  

By default, a report is re-saved to the location from which you opened it, so you should 

create reports only from the Reports Library.  

 

 

NOTE 

Did you know?  

When you save a “report”, you’re actually saving a report definition, 

which contains information about the report’s underlying query and 

presentation/layout. You are not saving the report’s data, which is 

pulled from the selected dataset at run time. The data is rendered 

for presentation in the layout’s defined formatting. Each time you 

open a report definition and run the report, the system will pull in the 

data made available as of the last DWH refresh.  

If you want to preserve a ”snapshot” of data in your report at a given 

point in time, you can export the output to .pdf, .xls, or other format. 

These copies can be filed, attached to an e-mail, archived, or 

printed later, at your convenience.  

You can also create report subscriptions for your report definition.  

A subscription results in an automatically generated report. The 

options can be configured to make a new version of the report to 

save in addition to the old ones, or to over-write and replace the last 

one generated so there’s always just one “most current” version.  
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There are three typical file types stored in the Reports Library: 

 

� .rds / .rsds – Shared Dataset 

� Shared Datasets can be cached and scheduled. 

� .rdl – Report Definition 

� Report Definitions include the report’s query and output design. 

� .smdl – Report Model  

� Report Models include a metadata description of business data used for 
creating ad hoc reports in Report Builder. 

� Although beyond the scope of the solution, Report Models can be 
managed and stored in the Reports Library. 

 
These file types represent “report objects” that can be used alone or together as 
appropriate to generate business intelligence for the organization.  
 
The solution does not permit reports to make connection(s) to data sources that exist 
outside of the Data Source and Reports Libraries, although it is possible to upload to 
the Reports Library reports and files including SQL queries and datasets that were 
developed elsewhere.  
 
In addition to report objects, other types of files and documents may be stored within 
the SharePoint site.  File types are limited only by the list of types supported by 
Microsoft.  It is possible to store logos and images, sound clips and clip art, 
photographs, and any type of MS Office file.   
 
The organization may define and configure a folder structure within the SharePoint 
site’s Reports Library for organizing saved reports and any other type of content to 
be retained in the library.  
 

 

 

TIP 

The person responsible for your organization’s solution 
should design and implement a folder structure and/or 
naming conventions for your SharePoint site to make it 
easier for Writers and Runners to locate and manage their 
report objects, files, and outputs. 
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Reports Executed Library 

 
The Reports Executed Library is where outputs from subscriptions are stored.   
 

As part of defining a report, Writers can establish a subscription, which is a recurring 

schedule for having the system run the report automatically.   

For example, you can create a Wait List Report, and have the system run that report for 

you every week on Monday morning after the DWH is refreshed.   

The schedule / subscription metadata is stored with the report definition in the Reports 

Library.  The output after the report runs is stored in the Reports Executed Library.   
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Accessing the Reports Library 

Click the Reports Library hyperlink in the Quick Launch area on the left side of the 

Welcome Page. The system will bring up the Reports Library interface.  

 

 

 

1.  Reports Library Hyperlink 

When you open the Reports Library, the view becomes more complex.   

Notice that you now have access to Library Tools (#2).  

In addition, the system now offers navigation “breadcrumbs” in the Site Ribbon (#3), 
and there are Report Objects inside the Working Pane (#4).  

 

2.  Library Tools 

Note that the Library Tools “tab” is merely a label. It has no functionality of its own. It 
exists only to guide the user to the features in the section.  

There are two tabs in the Library Tools section. The Document and Library tabs 
determine which ribbon appears.  Each ribbon has distinct tools and options. Not all 
users will see or be able to use the potential options. Options may be “grayed out” 
and/or the system may return an error message when options are not available. 

 



GETTING STARTED GUIDE HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 60 

 

Accessing the Reports Library (continued) 

 

 

 

2.  Library Tools (continued) 

Regardless of which ribbon/tab is selected, the Working Pane and Quick Launch 
remains the same.  

a.  Library Tools > Documents 

Documents Tools enable managing reports and documents.  

Some options will be disabled.  

 

 

b.  Library Tools > Library 

Library Tools are for managing the Reports Library. Most options will be 
disabled.  
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Accessing the Reports Library (continued) 

 

 

 

3.  Site Ribbon  

The Site Ribbon now displays “breadcrumbs” to assist in navigation.  Note the 
Browse tab to the left of the Library Tools (#2 above) tab. Click the Browse tab to 
enable hyperlinking within the Site Ribbon. 

Note that when you click either of the two tabs under Library Tools, the Site Ribbon 
disappears.  To restore the Site Ribbon for navigation, click the Browse tab. 

 

4.  Work Pane - Report Objects  

There are four columns in the Report Library’s Work Pane: 

a.  Type – The icon displayed will indicate if the object is a report or a dataset. 

b.  Name – Each object’s name is a link to the object. Hover over the name and the 

system will display a drop down arrow that can take you to the various options for 

working with the object. More explanation of the options themselves is provided 

later in this guide. 

  

c.  Modified – This column displays the date-time stamp for the last time the object 

was changed.  

d.  Modified By – This column shows which user made the most recent modification.  
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Accessing the Reports Executed Library 

Click the Reports Executed Library hyperlink in the Quick Launch area on the left side 

of the Welcome Page. The system will bring up the Reports Executed Library 

interface.  

 

The interface is essentially the same as for the Reports Library.  The only difference is in 

the types of items that display in the work pane.  

The Reports Executed Library will show executed reports (reports that have “run”) and 

report subscriptions rather than datasets and report definitions.  
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Scheduling Reports 
 
1.  Access the Reports Library. 
 

 
 
 
2.  Select the desired report (#1) and right-click Manage Subscriptions (#2). 
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3.  Click Add Subscription. 

 

 

4.  Complete the required fields to define the subscription.  

See next page for details about each of the fields to be populated.  
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Subscription Fields: 

 

1.  Delivery Extension = SharePoint Document Library. 

2.  Document Library = Reports Executed Library. 

3.  File Name = <reportname>_Report_Sub (or preferred naming convention). 

4.  Output Format = desired format. 

5.  Overwrite Options = desired option(s). 

6.  Delivery Event = On a custom schedule, then click Configure. 
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5.  The system will bring up the subscription scheduling window. 

 

1.  Configure Frequency. 

2.  Configure Schedule. 

3.  Configure Subscription Start and End Dates 

4.  Click OK.   The system will then show the new subscription: 

 

 

To delete a subscription, 1) Checkmark the target and 2) Click Delete.  
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Downloading Reports and Datasets 

 

1.  Go to the Reports Library. 

2.  Select the desired report or dataset. 

3,  Click Download a Copy. 

Follow the system prompts to save the item to your local machine.  
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Adding Documents to SharePoint 

In addition to storing report objects, there is an Add Document link at the bottom of 

the Work Pane in the Reports Library and in the Reports Executed Library.  

  

It is recommended that each organization establish a special folder within the 
Reports Library to store product and training related documentation. Items can then 

be added to the folder to make it easier to manage and retrieve reference materials.  

 

EXAMPLE 

The following steps show how to add a folder and upload a 
document. 

 

SharePoint:  Add Folder Feature 

Click the Library Tools > Documents tab, then click New Folder. 
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The system will bring up the New Folder window. 

 

 

1.  Name your folder with a name that will be easy to identify as “yours,” and then  

2.  Click Save.   

 

SharePoint:  Add Document Feature 

You can now place report objects into your folder.  You can also upload documents 

such as your training materials to your folder.  

Click the Library Tools > Documents tab, then click Upload Document. 
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Or - click the Add document link, and the Upload Document window opens: 

 

 

To add a document to the Library,  

1.  Click the Browse button. 

 

 

2.  Locate and select the item you wish to upload.  

     Click Open to insert the name of the document. 
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3.  When the document name displays in the Name box, click OK. 

 

The system will upload the document to the Library.   

 

 

TIP 

Uploadable items are limited to SharePoint’s supported file 

types.  Most MS Office files, Report Builder objects, 

datasets, .xml, and similar items can be uploaded with no 

problem.   

To avoid upload issues, SharePoint file names cannot 
exceed 128 characters, and special characters: (" # % & * 

: < > ? \ { | } ~ ) cannot be used in file names.  Also, files 
should be under 1GB.  

 

 

CAUTION 

You will want to pay attention to your current location and 

intended destination when uploading documents.  

If you need for an item to go into a specific folder, first make 

sure you are in the correct Library, then create the folder (if 

it doesn’t already exist), then go into the destination folder 

before trying to upload the document.   

Otherwise, you may have to delete the uploaded item and 

re-do the upload if it isn’t loaded to the correct destination 

the first time.  
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Deleting a Report or Dataset 
 
If you delete a dataset you will break any reports relying on that dataset.  This is the primary 
reason why it’s important to have a naming convention.  
 
Notice how the items below can easily be cross-associated: 
 

 
 
Both the Report Definition and the Dataset contain similar names.  With this approach, if 
you ever see a report without a dataset of similar name, you would know that the dataset 
has been deleted, or that the report was designed with an embedded dataset. 
 
To delete a report object of either type,  
 
1. Right-click the target;    and 2. Select Delete.   
 

  

After 30 days, items disappear from the recycle bin. If you need to recover an object that 

should not have been deleted, contact Harmony at support@harmonyis.com as soon as 

possible to increase the chance that the item can be recovered.  
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Closing 

Congratulations! 

 
You’ve completed Harmony Advanced Reporting - Getting Started Guide for Report 
Writers. 
 
For additional reference and practice, we recommend the other guide in the Harmony 
Advanced Reporting training series: 
 

• Harmony Advanced Reporting – Practice Exercises Workbook 
 

The Workbook provides step-by-step instructions for writing custom reports, following a 
variety of scenarios that are based on actual operational needs.   

 
We invite you to send us your comments and questions.  

(You can reach us at education@harmonyis.com) 
 

Welcome to the community of Advanced Reporting users! 
 


